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Featured Launch: Google for Work
Google Enterprise is now Google for Work
Released September 2, 2014

Share with your organization

Watch the launch video
What’s new: Ten years ago, we started bringing Google’s consumer technology—along with the features,
controls and services businesses need—to work. We first brought search and then Gmail to businesses.
Today we also offer the scale and reliability of Google’s infrastructure to developers with Google Maps and
Google Cloud Platform, and have extended into hardware with Android and Chromebooks. Along the way
we’ve invested in what matters to our customers and partners—security, transparency, compliance and
customer support. And our team, the breadth of our offerings, and our commitment to business customers
have all increased substantially.
We never set out to create a traditional “enterprise” business—we wanted to create a new way of doing work.
So the time has come for our name to catch up with our ambition. As of September 2, what was called
Google Enterprise is now, simply, Google for Work.
When we use the tools that make our lives easier—Google Apps, Maps, Search, Chrome, Android, Cloud
Platform and more—work gets better. And that’s what we’re working on—the best of Google, now for work.

For more information, check out the launch blog post and the Google for Work site.

2

Work together
Improved publishing interface for Google Docs, Sheets, and Slides
Released September 2, 2014

Share with your organization

What’s new: We have launched a new publishing interface for Google Docs, Sheets, and Slides. The interface
makes it easier for people to understand how document, spreadsheet, and presentation content can be
published as a webpage or embedded in their own website(s). In the new Google Sheets, the new interface also
provides the ability to publish specific sheets and charts without publishing the entire document.

How it works: In Google Docs, Sheets, or Slides, from the File menu, select Publish to the Web and
choose to link to or embed your content.
Check out the Help Center to learn more.

Simplified sharing experience for Google Docs editors and Google
Drive
Released September 4, 2014

Share with your organization

What’s new: We have launched a new simplified sharing experience for the Google Docs editors and Google
Drive, making it easier for people to find and copy the link for a file or folder to share with others.
How it works: To give access to your file to others, click the blue Share button (or select a file or folder in
Drive and click the person icon), and you’ll see a new Get shareable link button and grey icon in the upper
right corner of the popup window:

With one click on Get shareable link, you’ll see your file’s link appear and that the icon turns from grey to
green, meaning that the file is ready to be shared with viewonly access:

If you want anyone with the link to do more with your file, like leave comments and suggestions or make
edits, just change “Can view” to “Can comment” or “Can edit” in the dropdown. And as always, if you only
want certain people to be able to view, comment on, or edit your file, add their email addresses and we’ll
send them a link that only they can access.
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Check out the Google Drive blog post and learn more about sharing in the Help Center.

Work anywhere
Faster syncing, better uploads with the new Google Drive app on iOS
Released September 3, 2014

Share with your organization

What’s new: A new version of the Google Drive app for iOS is now
available in the App Store, containing the following features:
●
●

Faster syncing
New upload experience that shows progress and
destination

Get the Google Drive app in the App Store

Multiway video calls for Hangouts on Android and iOS without a G+
profile
Released September 10, 2014

Share with your organization

What’s new: People using the Hangouts apps on Android and iOS
are now able to participate in multiway video calls without a
Google+ profile.
This launch completed the rollout of the new Hangouts experience
announced for the web at the end of July.
How it works: Mobile Hangouts participants no longer need to
ensure Google+ premium services are enabled, nor have a Google+
profile to take part in multiway (or 1:1) video calls. Check out the full
list of features available to those with and without a Google+ profile
on mobile and the web.
See the Help Center and the Google for Work blog announcement
to learn more. Get the Hangouts apps on Google Play and the App
Store.

Simpler, faster experience for the mobile web version of Google Drive
Released September 25, 2014

Share with your organization
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What’s new: We’ve simplified the UI for the
mobile web version of Google Drive, making
it easier for people to access their files more
quickly.
How it works: People accessing the new
mobile web version of Drive will be able to
view, download and print their files. However,
to optimize the feature experience, they will
be directed to download the new Drive
(Android | iOS) and Docs editor apps for
document creation and editing.
Visit http://drive.google.com from your
mobile browser to give it a try.
Check out the Help Center to learn more.

Simple to use
Custom themes in Google Forms
Released September 2, 2014

Share with your organization

What’s new: Applying themes to forms is a great way to personalize and tailor them to their intended
audience. With this launch, people working with Google Forms will now be able to apply custom themes to
their forms.
This includes adding custom images or logos to the header and page background, specifying the font details
(type, size, color) and paragraph alignment for the form text, and choosing the color for the form and page
backgrounds. We’ve also refreshed the overall Forms UI and added a brand new gallery of modern default
themes.
In addition, if a form using a custom theme is shared within a domain, others can copy that theme in order to
use it themselves. This helps to ensure a consistent look and feel across forms used in that domain.

How it works: To add a custom theme, just create a new form and click the “Change theme” button in the
toolbar.
From there, you can add your own photos or logos to the header, customize fonts and colors, pick a
background, and more.
Check out the Help Center to learn more.

Present to everyone in Hangouts video calls
Released September 11, 2014

Share with your organization
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What’s new: Any participant in a Hangouts video call can now select a
participant to be shown to all other participants’ views. This feature
overrides the automatic speakerdriven switching for everyone in the call.
For example, if a participant is sharing a desktop view or showing
something live, anyone can make that the default view for all, so there is
no visual disruption to the meeting.
Anyone presenting in the same room using g.co/present/ will
automatically join in “Present to everyone” mode if there are no other
presenters.
How it works: When in a Hangout, click the dropdown menu on the photo thumbnail of the person you
want to have present, and select Present to everyone.
Check out the Help Center to learn more.

Automated lists, backspace to undo autocorrections in Google Docs
editors
Released September 16, 2014

Share with your organization

What’s new: In Google Docs, Slides, and Drawings, we will now automatically turn on bulleted or numbered
list mode when we detect that a person wants to make a list based on what was typed as the first visible
character in a paragraph.
How it works: For example, if a hyphen [] or
an asterisk [*] is typed as the first visible
character, followed by the space bar, it would
be automatically be turned into a bulleted list
without the person having to press a shortcut or
toolbar/menu button. Typing ‘1)’ or ‘a.’ followed
by the space bar would turn into a numbered
list, as would other permutations like I., (A),
etc.
The automated lists feature will be defaulted on,
but users will be able to disable it in Tools >
Preferences.
Coupled with this launch, pressing the backspace button immediately after any autocorrection, including
automated lists, will undo it. For example, if a person types ‘(c)’ and the autocorrect system converts it to the
copyright symbol ‘©’, pressing backspace immediately after it will revert it back to ‘(c)’.
For more information:
● Format bulleted and numbered lists
● Spellcheck and automatic corrections

Better file navigation for all Google Drive pickers
Released September 17, 2014

Share with your organization

What’s new: We have launched a new UI for all Google Drive pickers—the interface that allows people to
select and insert content stored in Google Drive. The UI makes it simpler and easier to find and insert your
desired files with multiselection of Drive items, list view with owner and date header sorting and grid view
which surfaces your folders first.
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How it works: The file picker can be seen when you insert from Drive in Gmail as well as when you open
files or insert images into Google Docs, Sheets, and Slides.
Check out the announcement on the Google Drive G+ page

Support for thirdparty internationalized email addresses in Google
Calendar
Released September 18, 2014

Share with your organization

What’s new: As announced in August for Gmail, we launched support for internationalized email addresses
in Google Calendar.
How it works: This will allow people to use email addresses that contain accented or nonLatin characters to
invite guests and share calendars, and perform any other action where email addresses are used by
Calendar. This includes both the domain name (to the right of the @ symbol) and/or the localpart (to the left
of the @ symbol), as in 武＠メール.グーグル.
Read more about Google’s push for email internationalization.

Smarter ‘Other calendars’ list order in Google Calendar
Released September 25, 2014

Share with your organization

What’s new: To more easily make visible or hide
calendars from the ‘Other calendars’ section in Google
Calendar, we’ve made a change to its list order
behavior.
How it works: Calendars selected for viewing will now
move up to the top of the list in alpha order, leaving the
remaining unchecked calendars below in alpha order.
Check out the Help Center for more information

More ways to build and share Google Forms
Released September 29, 2014

Share with your organization

What’s new: We launched several new features in Google Forms, making them easier to build and share:
Find what you’re looking for
● Search the menus: Quickly access nearly all features in Forms without having to dig through
menus. To use this feature, press Alt + / or look under the Help menu
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New ways to manage your questions
● Shuffle questions: Randomize the order of questions on quizzes or surveys
● Allow one response per person: Ensure that a person only responds to your form once
● Validate information for grid questions: Limit people to one response per column for gridstyle
questions using the new option under Advanced settings in the Edit questions view
Get the word out with shorter URLs
● Shorten URLs to your forms: Make it easier for people to get to your form

Check out the Google Drive blog post announcing these features, and learn more about all the ways you can
use Google Forms at google.com/forms/about

Google Sheets addon for linear optimization
Released September 30, 2014

Share with your organization

What’s new: Got a problem that can be described with linear inequalities? Whether you're working to
optimize distribution networks or delivery routes, or simply getting the best staff schedules and optimizing
your finances, the Google Sheets addon for linear optimization can now help you do the math.

How it works: Get the addon from the Sheets addon store, place your variables and constraints in Google
Sheet cells, and Google servers will compute a solution with the click of a button.
This addon is one of many available. Remember to check out the complete store for Docs and Sheets
often—more useful tools are being added each week.
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Business ready
More transparency for reporting data in Admin console and API
Released September 9, 2014

What’s new: We have introduced a date picker at the top right of
the Reports section in the Admin console to provide additional
transparency into any reporting delays and unblock partial data
feeds in the event some data is unavailable.
How it works: The latest date for which all data points are
present (usually 2 days prior to the current day) has a green
background. When this date gets delayed beyond the standard 2
days delay, admins can choose a later date to access data which
is not delayed and is available at the selected date.
On the API side, the API will return data for the latest available
report date and admins will be able to select older dates when
data gets delayed. The API will also return a warning if some of
the data is missing.
Check out the Help Center to learn more.

Google Apps Marketplace: whitelisting apps, access for nonadmins
Released September 17, 2014

Admin action needed

What’s new: The Google Apps Marketplace has a widevariety of
options, no matter your taste, including Smartsheet for online
project management, Freshbooks for accounting, Zoho for
customer support, GQueues for todo lists and more.
This launch gives the ability for Google Apps admins to open up
the Google Apps Marketplace (GAM) to people from their
organization to directly find and use 3rd party applications that
integrate with Google Apps.
How it works for admins: Admins can choose to allow the
installation of any GAM apps, or they can choose to customize
and whitelist which apps are made available to their domains.
Admins can also turn the feature off altogether if they so choose.
How it works for employees: To find and add thirdparty apps for
Google Apps, click the app launcher icon, click More, and click
More from Apps Marketplace.
Read the full announcement on the Google for Work blog and
check out the Help Center to learn more.

Increased security for iOS devices with iOS Sync for Google Apps
Released September 17, 2014

What’s new: We introduced a new iOS Mobile Device Management (MDM) solution known as iOS Sync for
Google Apps, which integrates Google mobile apps with native iOS device management. Users of Gmail,
Drive, Docs, Sheets, and Slides on their iPhones and iPads receive all the benefits of Google Apps on iOS,
and organizations maintain the security they need.
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The advantages of iOS Sync for users and administrators include:
●

●

●

Manage Google Apps: Set a policy that prompts employees to
enroll their device when they log into Google Apps such as Google
Drive and Gmail.
Configure WiFi networks: Distribute WiFi passwords and
certificates to employees so they can easily connect to trusted
networks.
Support for existing policies: Manage password requirements,
data encryption and camera policies, as well as actions like
remotely wiping a device, activation approvals and blocking devices.

In addition, customers who are using our existing Google Sync MDM
solution now have the option to disable ActiveSync while continuing to
manage iOS devices in their organization.
How it works: iOS Sync (which works with iOS 7 and iOS 8, and the new iPhone 6 and 6+) is now available
for Google Apps for Work, Google Apps for Education and Google Apps for Government. Admins should
access the Device management function in the Admin console to establish an Apple push notification
certificate and begin enabling these new functions.
Check out the official announcement on the Google for Work blog and the Help Center to learn more.

Enhanced Google Apps Directory Sync v4.0.1
Released September 23, 2014

What’s new: We launched Google Apps Directory Sync (GADS) v4.0.1 with a number of new features and
bug fixes.
How it works: See the Help Center for more info and release notes.
Note: GADS now uses the Directory API instead of the deprecated Provisioning and Profiles Data APIs. We
strongly recommend switching to the latest version of GADS. Old GADS versions will stop working once the
Provisioning and Profiles Data APIs are discontinued on April 20, 2015.

Manage Chrome policies on Android and iOS from Google Admin console
Released September 23, 2014

What’s new: Since April 2013, admins have had the capability to set 100+ Chrome policies
for users on Chrome Devices, Windows, Mac, and Linux when they signin to Chrome with
their Google Apps account.
This launch provides an early preview of applying some of these same policies to Chrome on
Android and iOS as well.
How it works: As an example, you can set bookmarks through the Managed Bookmarks setting on Google
Admin console and it gets pushed to Chrome on all 6 platforms, including mobile. Similarly, you can set the
Proxy policy or the Password Manager policy once and it will apply on Chrome on all 6 platforms.
See the Help Center for more information on how to turn on this early preview feature.

Custom user attributes, opening up access to all domain users in Admin SDK
Released September 23, 2014

Share with your organization

What’s new: The Admin SDK provides a comprehensive directory
experience for Google for Work customers to help them meet specific
business needs around data storage for customers. Here are some important
updates to the SDK:
Custom attributes in the user’s profile
Now available is a new feature in the Directory API which allows you to add custom attributes for
your users. For instance, you could store the projects your users work on, their desk number, job
level, hiring date—whatever makes sense for your business.
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Once the custom attributes for your domain have been defined, they behave just like regular fields in
the user profile. You can get and set them for your users and also perform searches on custom fields
(e.g. “all employees that work on the shinyNewApp in Hyderabad”).
Custom attributes can be of different data types; they can be single or multivalued. You can
configure whether they are “public,” i.e. visible to everyone on the domain, or “private,” i.e. visible only
to admins and the users themselves.
Read access to all domain users
Historically, only admins have been able to access the data in the Admin SDK. With this launch,
employees (not just admins) will now be able to call the Directory API to read the profile of any
person on the domain (of course, we will respect ACLing settings and profile sharing settings).
Use cases: We hope that you will be able to use this new feature to build business applications (e.g.
corporate yellow pages, expense approval, vacation management, workflow applications, etc.) that can be
used by everyone in your organization.
Learn more about the Admin SDK and the Directory API.

Better search and more with the new Google Admin app on iOS
Released September 30, 2014

What’s new: A new version of the Google Admin app for iOS is now
available in the App Store. This latest release (v1.1.0) contains the
following features:
●
●
●
●
●
●

Instant search for finding users
Unifying the search fields for first name and last name for ease of
use
Ability to switch between multiple accounts quickly
Conforming the UX to iOS 7 guidelines
Adding a settings page with settings like remember password, etc
Accessibility fixes

How it works: The app lets admins manage their Google for Work
products on the go (add and manage users and groups, contact support,
and view audit logs for your organization) with their iPads and iPhones.
Get the Google Admin app in the App Store.
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Learn more about Google Apps
Google Apps for all: The Apps Show on YouTube, every Wednesday at 11am PST
Share with your organization

What’s new: In September, The Apps Show covered a whole bunch of
useful features in Hangouts. Debbie and John offered pro tips to run
Hangouts on Air, demonstrated the Eject button, /ponies and more.
To know: The audience loves The Apps Show. Engaging comments
and Google+ shares keep flowing in. Season One has now clocked
nearly 100,000 views. The team is preparing Season Two to launch on
Oct 8.
Bookmark The Apps Show playlist on YouTube

What’s New in Google Apps webinar video recordings
Share with your organization

What’s new: We’ve changed the format of our popular
What’s New in Google Apps webinar series from scheduled
live sessions to video recordings hosted on YouTube, so
you can watch and share them whenever you want.
How it works: The What’s New webinars provide a recap of
all of the features we've released in the past month (think of
it as a video version of this newsletter).
The recap of August launches is currently posted and the
September recap will be posted in the second week of
October. Moving forward, you can access all video
recordings in the archive on the What’s New site.
Bookmark the webinar archive page and check back each month for new recordings.

Thanks for checking out our newsletter!
We’d really appreciate your thoughts on how we can make this work best for you.
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